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1 Getting Started
Your PowerBook has been designed so that you can set it up quickly and start using it right 
away. If you have never used a PowerBook or are new to Macintosh computers, read this 
section for instructions on getting started and where to get more information. 

If you are an experienced user, you may already know enough to get started. Be sure to look 
over the information in Chapter 2, “Getting to Know Your Computer,” to find out about the 
new features of this PowerBook.

Note:  Your computer may not include the A/C plug.

Composite-to-S-video cable

A/C cordPower adapter

A/C plug

Phone cord

Important  Read all the installation instructions and safety information (see page 99) 
carefully before you plug your computer into a wall socket.
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Plugging In the Computer

Plugging in the power adapter provides AC power to the computer and recharges the 
computer’s battery. You should plug in the power adapter in case the battery has been 
drained during shipping or storage.

1 Plug the A/C plug on the power adapter into an outlet. 

A light appears on the power adapter plug. An amber light indicates that the battery is being 
charged. A green light indicates that the battery is fully charged.

2 Plug the power adapter plug into the power adapter port (marked with the icon ¯) on the 
back of the computer.

You can wrap the extra adapter cable around the clips that open out from the power adapter.

Note:  There may be a small gap between the A/C plug and the power adapter. You can also 
remove the A/C plug and plug one end of the A/C cord into the adapter and the other end 
into an outlet.

Connecting the Internal Modem

If you want to connect to the Internet right away, connect one end of the phone cord to the 
internal modem port (marked with the icon W) and the other end to an analog telephone 
line (the type of telephone line found in most residences).

G

™

Æ
W

Internal modemPower adapter plugA/C plug ¯ Power adapter port W

Telephone cord

A/C cord Power adapter

Warning  Do not connect a digital telephone line to the modem, because the wrong
type of line could damage the modem. Contact your telephone service provider if you
are unsure whether you have a digital telephone line.
8 Chapter  1  



       
Opening the Display

1 Push the display release button.

2 Open the display and position it at a comfortable viewing angle.

®
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Turning the Computer On

To turn on the computer, press the Power button (®). You should hear a tone when you 
turn on the computer. It takes the computer a few moments to start up. This is normal. 
When you press the Power button, the PowerBook checks its memory before it starts up. The 
more memory installed, the longer the delay.

® Power button

®

Problems Turning the Computer On?

Nothing happens when you press the Power button.

m The battery may be drained. Make sure that you plugged in the power adapter 
firmly into both the computer and a power source. The power adapter plug glows 
when connected properly to the back of the PowerBook.

m If the computer still doesn’t start up when you press the Power button, use the end 
of a paper clip to press the reset button (see page 20) on the back of the computer. 
Make sure the button releases to its original position after you have pressed it. Wait 
a few seconds and then press the Power button again. 

m If the computer still doesn’t start up, see page 91 for more troubleshooting 
suggestions.

You see a picture of a disk or a folder with a blinking question mark.

m This icon usually means that the computer can’t find system software on the hard 
disk or any disks attached to the computer. You may need to reinstall system 
software. See page 90.
10 Chapter  1  



              
Moving Items on the Screen

You use your PowerBook trackpad to move items and select items on the screen, much as 
you use a mouse with a desktop computer. To move the arrow pointer on the screen, slide 
your finger across the trackpad. To select, click, or double-click an item on the screen, use 
the trackpad button.

Note:  Instead of using the trackpad button, you can click and double-click directly on the 
trackpad. You turn on this option in the Trackpad control panel in Mac OS 9, or in the Mouse 
pane of System Preferences in Mac OS X.

The trackpad is sensitive to how quickly you move your finger. To move the pointer a short 
distance across the screen, move your finger slowly across the trackpad. The faster you move 
your finger, the farther the pointer moves on the screen. 

®

Trackpad Trackpad button

Tips for Using the Trackpad

For best results when using the trackpad, keep in mind these tips:

m Use only one finger. Do not use a pen or any other object. 

m Keep your finger and the trackpad dry. If the trackpad becomes moist from 
humidity or condensation, gently wipe it with a clean cloth before you use it. 

m Never use any kind of cleaning solution on the trackpad.

For more information on using the trackpad, see Mac Help or Mac Tutorials, available 
in the Help menu.
 Getting Started 11



        
Adjusting the Internal Display

Before you begin working with your new PowerBook, you may need to adjust your display so 
that items on the screen are easy to see. 

Adjusting the Brightness

Use the keys labeled with the ¤ icon to adjust screen brightness.

®

¤ Brightness controls
12 Chapter  1  



            
Adjusting the Display Resolution

You can increase the size of images on your display by switching from the standard resolution 
to a scaled resolution. To adjust the resolutions on your display:

m In Mac OS 9, click the Resolution icon in the Control Strip. 

m In Mac OS X, click the Displays pane of System Preferences. To control your display 
settings from the Displays icon in the menu bar, click “Show displays in Menu bar.”

Resolutions Supported by the Built-In Display

Your PowerBook has a wide screen display with a native resolution of 1152 x 768 that also 
supports standard resolutions such as 1024 x 768. When you use a standard resolution, a 
black band appears on each side of the display.

Most applications automatically switch to the best resolution for them.

You may want to use a standard resolution when mirroring your display on an external 
monitor or when using certain applications (such as games or presentation software) that are 
designed for a standard resolution.

If you use an application designed for a standard resolution and do not want to see the black 
bands, you can choose the “stretched” version of the resolution to stretch the image to cover 
the entire screen and eliminate the black bands. To access additional stretched resolutions in
Mac OS 9, hold down the Control key when you click the Resolution icon in the Control 
Strip.

In Mac OS X, you can choose a resolution of 896 x 600 or smaller in the Displays icon in the 
menu bar. These are known as “scaled resolutions.” When you switch to a scaled resolution, 
items on the screen appear larger, making them easier to see. However, scaled resolutions 
may not be as sharp as the display’s native resolution.

Resolution icon
 Getting Started 13



                
Where to Go From Here

You’ve done everything you need to get your PowerBook up and running. The first time that 
you turn your computer on, the Macintosh Setup Assistant takes you through the process of 
configuring your computer and setting up for the Internet.

If you would like additional information, see the following:

Calibrating Your Battery for Best Performance

To get the longest running time from your PowerBook battery, let the battery run down 
during the first week you have your PowerBook. Then fully charge it one time. Follow 
these steps:

1 Plug in the power adapter and fully charge your PowerBook battery until the battery 
indicator lights and the onscreen meter (see page 56) indicate that the battery is fully 
charged.

2 Disconnect the power adapter and use your PowerBook until you see the first low 
battery warning dialog box on the screen.

3 Connect the power adapter and leave it connected until the battery is fully charged again.

To learn about... See...

Shutting down your computer or putting it to 
sleep

“What to Do When You Are Finished Working” 
on page 15.

What you can do with the hardware and 
software features of your PowerBook

Chapter 2, “Getting to Know Your Computer.”

The additional information available in the 
onscreen help

“Mac Help—Answers to All Your Macintosh 
Questions” on page 42.

Using a specific feature of your PowerBook Chapter 3, “Using Your Computer.”

Installing memory Chapter 5, “Working Inside Your Computer.”

What to do if you have a problem with your 
PowerBook

Chapter 6, “Troubleshooting.”

Important  You only have to fully discharge and then charge your battery once to calibrate 
it. After that, you can connect and disconnect the power adapter when the battery is at any 
charge level.
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What to Do When You Are Finished Working

When you have finished working with your PowerBook, you have two options.

Put Your PowerBook to Sleep

If you will only be away from your PowerBook for a short time, put the computer to sleep. 
When the computer is in sleep, you can quickly wake it and bypass the startup process. When 
the computer is in sleep, its screen is dark and a small white light below the display pulsates.

To put the computer to sleep quickly, do one of the following:

m Close the display.

m Choose Sleep from the Special menu in Mac OS 9, or from the Apple (K) menu in 
Mac OS X.

To wake the computer:

m If the display is closed, open it. Your PowerBook wakes from sleep when you open the 
display. ( You can turn off this option in the Energy Saver Control Panel in Mac OS 9.)

m If the display is already open, press the Power button (®) or any key on the keyboard.

Shut Down Your PowerBook

If you will not use your PowerBook for a day or two, shut it down. Do one of the following:

m Choose Shut Down from the Special menu in Mac OS 9, or from the Apple (K) menu in 
Mac OS X.

m Press the Power button and click Shut Down in the dialog box that appears on the screen:

If you plan to store your PowerBook for an extended period of time, see “Storing Your 
PowerBook” on page 99 for additional steps to prevent your battery from draining 
completely.

Warning  Wait a few seconds until the sleep light starts pulsating (indicating that the 
computer is in sleep and the hard disk has stopped spinning) before you move your 
PowerBook. Moving your computer while the hard disk is spinning can damage the hard 
drive, causing loss of data or the inability to start up from the hard disk.
 Getting Started 15
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2 Getting to Know Your Computer
If you’re eager to get started and want to try out a few things on your PowerBook, this 
chapter is for you. It provides an overview of your computer’s hardware and software 
features along with the unique Internet services available to Mac owners. 

Your PowerBook is a full-featured notebook computer. It includes the latest in computer 
technology such as a PowerPC™ G4 processor, FireWire, USB, and AirPort wireless Internet 
and networking. On top of this hardware runs the Mac OS operating system. Included with 
the Mac OS are powerful features that allow you to use the Internet to watch video, research 
information, shop, and even update your software automatically.

With your PowerBook you also get iMovie, an easy-to-use digital video editing application 
that lets you use your PowerBook to create desktop movies. Simply connect a digital video 
camera to the FireWire port on your PowerBook, open iMovie, and you’re ready to create 
your own movies.

Your PowerBook also comes with iTunes, the digital audio program that lets you import 
songs from your music CDs, create your own iTunes library, listen to hundreds of Internet 
radio stations, and burn your own CDs.

On top of all this, Apple provides you with free Internet services that give you storage space 
on the Internet, a personal Mac.com email address, tools to easily create your own Web site 
or iMovie theater, and more.

If You Are New to the Mac

If this is your first Macintosh computer, start with the Mac Tutorials to learn how to use the 
trackpad to move items on the screen, go to a site on the World Wide Web, and more. To 
access the tutorials in Mac OS 9, choose Mac Tutorials from the Help menu.

Note:  Because Apple frequently releases new versions and updates to its system software, 
applications, and Internet site, images shown in this manual may be slightly different from 
what you see on your screen.
 17



   
Basic Features of Your PowerBook

®

Built-in speaker

® Power button

Security slot

AirPort antenna
window

Built-in speaker/
microphone

Sleep indicator light

Function
key (Fn)

Trackpad
button

Display
release button

Trackpad Slot-loading
optical drive (DVD-ROM
or CD-RW)

Volume
controls

Keyboard
release tab

¤ Brightness
     controls

Keyboard lock/
Num Lock indicator light

Num Lock
key

Keyboard
release tab

— Mute
   control

-

Media
Eject key

Programmable
function keys
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¤ Brightness controls

Increase or decrease the brightness of your PowerBook display.

- Volume controls

Increase or decrease the volume of the sound coming from the built-in speakers and sound 
output port.

Keyboard lock

Protect the internal components of your PowerBook by preventing the keyboard from 
being easily opened.

Num Lock key

Activate the numeric keypad embedded in the PowerBook keyboard. When the numeric 
keypad is locked, the keyboard lock glows green.

Media Eject key

Press and hold this key to eject a CD or DVD disc. You can also eject a disk by dragging its 
icon to the Trash.

® Power button

Turn your PowerBook on and off or put it to sleep.

Slot-loading optical drive (DVD-ROM or optional CD-RW)

If you purchased your PowerBook with a DVD-ROM drive, it can read CD-ROM discs, Photo 
CDs, standard audio discs, DVD discs, DVD movies, and other kinds of media. If you 
purchased the optional CD-RW drive, it can read CDs and also write music, documents, and 
other digital files on CD-R and CD-RW discs.

Function (Fn) key

Press and hold this key to activate the function keys (F1–F12).

Keyboard release tabs

When you need to access the internal memory slots, pull these tabs down to release the 
PowerBook keyboard.

Microphone

Record sounds directly on your PowerBook hard disk with this built-in microphone 
(located under the speaker cover). You can also connect an external microphone to one of 
the USB ports or use a professional microphone that connects to a PC Card.

Ç Security slot

Protect your PowerBook by connecting a security cable.

Sleep light indicator

A white light pulsates when the PowerBook is in sleep.

Trackpad

Move the pointer on the PowerBook display. With the Trackpad control panel, you can set 
the trackpad to double-click and select items directly instead of using the trackpad button.
 Getting to Know Your Computer 19



Additional Features of Your PowerBook

G

™

Æ
W

PC Card slot

PC Card
eject button

AirPort
antenna
window

W Internal
     modem port

Headphone
port

Infrared
window

    USB ports

¯ Power
     adapter port

™ External
      monitor port

Ethernet port
(10/100/1000Base-T)

Reset buttonG

FireWire
port

Sleep indicator light

TV out portÆ

f

G ™ W
1 2
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FireWire port

Connect high-speed external devices, such as digital video cameras, printers, and external 
storage devices.

G Ethernet port (10/100/1000 Base-T)

Connect to a high-speed 10/100/1000Base-T Ethernet network or connect to another 
computer and transfer files. The Ethernet port auto-sensing feature detects other
Ethernet devices. You don’t need an Ethernet crossover cable to connect to other 
Ethernet devices.

Two USB (Universal Serial Bus) ports

Connect additional equipment to your PowerBook, such as printers, external storage 
devices, modems, keyboards, and joysticks.

™ External monitor (VGA) port

Connect to an external monitor or projection device that uses a VGA-style connector.

Æ TV out (S-video out) port

Connect your PowerBook to a television, VCR, or other video device. You can use TV out 
for presentations or to play a DVD movie on your television.

PowerBook reset button

Reset the computer with this button when you cannot shut it down using the Power button 
or when it will not restart properly.

W Internal modem port

Connect a standard phone line directly to the internal modem.

Infrared window

Use infrared (IR) communication to send files to another IR-equipped computer, print on 
an IR-equipped printer, or connect to an IR network that uses the IrDA standard. You can 
also use IR to synchronize with certain handheld personal assistants or a cellular telephone 
to connect to your Internet service provider (where applicable).

f Headphone port

Connect external speakers, headphones, or other sound output devices.

PC Card slot

Expand the capabilities of your PowerBook using the Type II slot that supports both PC 
Card and CardBus formats.
 Getting to Know Your Computer 21



Inside Your PowerBook

Battery

Serial number Ethernet ID and AirPort ID

®

Keyboard
flipped over

PowerBook with the keyboard flipped over and internal RAM slot visible

PowerBook turned over

Upper
memory
slot

Lower
memory

slot (filled)
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Memory slots

Your PowerBook comes with two memory slots, one above the other. The lower slot 
contains the memory module that came with your PowerBook. You can install an additional 
memory module in the upper slot. (If you ordered your PowerBook with additional 
memory, the upper slot may already be filled.) The maximum amount of RAM you can 
install in your PowerBook is 1 gigabyte (GB), using a 512 megabyte (MB) memory module 
in each slot. For instructions, see “Installing Additional Memory” on page 69.

Removable hard disk

You can remove the internal hard disk for service or security. For instructions, see 
“Removing the Internal Hard Disk” on page 78.

AirPort Card

The AirPort Card in your computer allows access to a wireless network.
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About Mac OS X

Apple menuC

Use this to
change settings, 

open recently
used items, and
shut down your 

computer.C

Window with 
buttonsC

Click a button to 
close the window, 
minimize it in
the Dock, or 
enlarge it.

Finder toolbarC

Click to open 
folders, files, and 
shortcuts to 
places on your 
computer. 

DockC

Click an icon in the Dock to open 
that item or make it active. Some 
icons in the Dock indicate the 
status of an application.C

SheetC

Sheets for 
saving and printing 

are attached to 
document
windows.

ButtonC

If a button pulses, 
you can press the 

Enter or Return 
key instead of 

clicking it.

Status IconsC

Check the 
status of System 
Preferences from 
the menu bar.
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What You Can Do

Mac OS X provides a powerful and elegant new user interface for your computer. With 
Mac OS X, you don’t need to worry about the amount of memory to allot for an application 
to run efficiently, or restarting your computer if something goes wrong with an application. 
In addition to using Mac OS X software, you can still run Mac OS 9 versions of software in 
Mac OS X using the Classic environment. Chapter 4, “Working With Your Operating 
System,” on page 65 explains Classic in more detail. Mac OS X also supports Java™ and 
UNIX-based software.

To Get Started

System Preferences is your command center for all of your computer settings, from changing 
the appearance of your desktop to setting up network access information. The Finder and 
Dock provide easy access to folders, applications, documents, and other items on your 
computer and network. 

For details on the features of Mac OS X, see the Welcome to Mac OS X book that came with 
your computer or choose Mac Help from the Help menu in Mac OS X.

Tips and Tricks

Personalize the Finder

You can select a picture or color for your desktop by choosing the Desktop pane of System 
Preferences. You can also select and rearrange the items that appear in the Finder toolbar. 
Choose Customize Toolbar from the View menu and drag items to the toolbar.

Personalize the Dock

You can change the size of the Dock icons, turn on magnification so that the icons under 
your pointer become larger than the rest of the Dock, and position the Dock on the bottom, 
left, or right of your screen. Choose Dock from the Apple (K) menu, then choose Dock 
Preferences. You can also open your computer’s System Preferences and click Dock.

Keep your desktop organized

Reduce the clutter on your desktop by minimizing open windows, which puts them in the 
Dock. Double-click a window’s title bar or click the middle button in the top-left corner of 
the window to put it in the Dock. Click the window’s icon in the Dock to open it again. You 
can also control some system settings using the status icons in the menu bar.

To Learn More

For instructions on how to customize your Mac OS X environment and for more information 
about using Mac OS X, see the Welcome to Mac OS X book that came with your computer.
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iTools—Free Internet Services for Mac Users

EmailC
Get your own Mac.com email address. 
It’s easy, and it works with your favorite 
email programs. 

iDisk
Your own 20 MB of free storage 
on Apple’s Internet server. Share photos, 
movies, and other files over the Internet. 
Purchase additional storage space.

HomePageC

Build a personal Web site in three easy 
steps. Create a photo album, publish an 
iMovie, post your résumé, and more. 
Now anyone can view your page on the 
Internet.

iCards
Send an elegant iCard, just right for any 
occasion. Choose a ready-made photo, 
or create a personalized iCard using 
photos on your iDisk.
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What You Can Do

iTools is a new class of Internet services from Apple created exclusively for Mac users. With 
iTools, you can send email or greeting cards to your friends and share photos and movies. 
You can even create your own Web site.

To Get Started

1 Connect to the Internet.

2 Go to www.apple.com

3 Click the iTools tab and then click the Free Sign Up button. 

Tips and Tricks

Upload pictures to your iDisk to create custom iCards

You can send iCards with your own custom pictures. Save your images as GIF or JPEG files 
and then copy them to the Pictures folder on your iDisk. Your images will appear as picture 
choices when you create an iCard in the Create Your Own section.

Start with a HomePage template to create your own Web page in minutes

HomePage has Web page templates that you can modify with your own text and images. For 
example, teachers can use the HomePage education templates to post recent class news, 
homework assignments, and other information for parents. You can also use the HomePage 
photo album and iMovie templates to share your pictures and movies easily with your friends 
and family.

Instead of using a Web browser to open your iDisk, you can open it directly:

m In Mac OS 9, select the icon of your iDisk and choose Make Alias from the File menu. 
Whenever you want to access your iDisk, double-click the alias and enter your password. 

m In Mac OS X, click the iDisk icon in the Finder toolbar, or choose iDisk from the 
Go menu.
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Sherlock 2—Your Internet Search Detective

Search buttonC

After you type what 
you are looking for, 
click this button to 
start the search.

Search sitesC
Sherlock searches
the Internet using 
several search 
engines.

Sherlock channelsC

Search the Internet for 
people, shopping, news, 

Apple info, and more.

Sherlock iconC

Click the Sherlock 
icon in the Dock.
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What You Can Do

Sherlock 2 is your search detective and personal shopper on the Internet. It provides an easy 
way to find people, news, and just about anything. Shop for books and music and search 
auction sites, find the best prices—even check product availability.

To Get Started

1 Connect to the Internet.

2 Open Sherlock:

m In Mac OS 9, double-click the Sherlock icon on the desktop. You can also choose Search 
Internet from the File menu or choose Sherlock from the Apple (K) menu.

m In Mac OS X, click the Sherlock icon in the Dock. You can also choose Find from the File 
menu to find files on your computer.

3 Select a Sherlock channel.

4 Type what you are looking for and click the Search button.

Tips and Tricks

Create your own customized Sherlock search channel

1 Choose New Channel from the Channels menu.

2 Select a name, channel type, and icon.

3 Download Sherlock plug-ins and drag them into the Search Sites list. Or hold down the 
Option key and drag plug-ins from other search lists to the icon of your new channel.

To Learn More

To learn more about what you can do with Sherlock, open Mac Help and search for 
“Sherlock.” To download additional search plug-ins and find out how you can create your 
own Sherlock plug-in, go to the Sherlock Web site at www.apple.com/sherlock 
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Apple.com—Your Starting Place on the World Wide Web

Software made for Mac 
www.apple.com/softwareC
Search by category for Apple 
and third-party software for 
your Mac.

The Apple Store
store.apple.comC
Purchase the latest

Apple hardware, software,
and accessories.

Macintosh
Products Guide

www.apple.com/guideC

For great hardware and software 
products for your Mac, check 
this Web site or look for 
the Mac symbol.
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Apple Hot News 
www.apple.com/hotnewsC

Find information on the latest 
software updates for your Mac, 
third-party software, QuickTime 
Hot Picks, and information on 
the next big Apple event.

Apple Support 
www.apple.com/supportC

Find information about the 
AppleCare Protection Plan, 

training programs, and other 
product support. Also access 

software updates, the
Apple Knowledge Base, and 

technical information.

Mac OS X 
www.apple.com/macosx/C

Get the latest on the world’s most 
advanced operating system.
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QuickTime—Audio and Video on the Internet

Volume control

QuickTime TVC

Click to view the 
QuickTime TV 
channels you can 
access on your 
computer.

QuickTime iconC

Click the QuickTime 
icon in the Dock.
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What You Can Do

In addition to playing video and music files on your Mac, with QuickTime you can watch live 
and recorded Internet broadcasts. Store channels that you frequently view by dragging them 
to your personal list of QuickTime Favorites ( ).  

To Get Started

1 Connect to the Internet.

2 Open QuickTime Player:

m In Mac OS 9, double-click the QuickTime Player icon on the desktop. You can also
open the Applications folder, then open the QuickTime folder and double-click 
QuickTime Player.

m In Mac OS X, click the QuickTime Player icon in the Dock. You can also double-click 
QuickTime Player in the Applications folder.

3 Select a channel or choose an option from the QuickTime Player menu. QuickTime TV uses 
Internet streaming, so you get the latest video, music, and information over the Internet 
without having to store files on your hard disk.

You can view your QuickTime Favorites ( ) by choosing Favorites from the QTV menu, then 
choosing Show Favorites from the submenu.

Tips and Tricks

Add additional QuickTime TV channels

Go to www.apple.com/quicktime and click the QuickTime TV link. There you will find all of 
the available QuickTime channels. You can watch a QuickTime TV (QTV ) channel and with 
one click add it to your QuickTime Favorites list.

Upgrade to QuickTime Pro to do the following:

m Play back full-screen video and resize movies.

m Create streaming movies.

m Work with more than 30 audio, video, and image formats, including Flash.

m Create, open, edit, and save movies and audio as easily as copying and pasting.

To Learn More

Internet video is just one of the things you can do with QuickTime. To learn more, start with 
QuickTime Help. To download additional channels or find information on setting up your 
own Internet streaming server, go to the QuickTime Web site at www.apple.com/quicktime

♥

♥
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iMovie 2—Create and Edit Your Own Digital Movies

iMovie monitorC

Preview your 
movie or view 

video directly from 
a connected DV 

camcorder.

Playback controlsC

Use these to play the 
movie in the iMovie 
monitor.

Mode switchC

Use this to
switch between 
importing from

a camcorder
and editing.

Timeline 
viewerC

The clip viewer 
and the timeline 

viewer are
visual aids for 

assembling and 
editing your 

movie.

Editing 
buttonsC
Click these to 
open panels for 
adjusting and     
selecting sounds, 
video effects, 
titles (text), and 
transitions. Click 
the Clips button to 
see the shelf. 

Scrubber barC

Use this to select  
sections of video.  

Audio tracksC

Lets you work with 
recordings, music, and 
sound effects.

PlayheadC

Represents the 
location of the frame 
showing in the iMovie 
monitor. Move the 
playhead to see 
where things appear 
in a movie.

Video trackC

Lets you work 
with audio 

contained in
video clips.

Clip viewerC
 

ShelfC

To make clips part 
of your movie after 
you import them, 
drag them from 
the shelf to the 
clip viewer. 
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What You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital 
video camcorder, you can create and edit your own movies. Import video from the camera, 
edit clips, and add transitions, titles, sound effects, and music. Then copy the movie to a 
camcorder tape or create a QuickTime movie. You can even share your QuickTime movies by 
placing them on the Web on your Apple iDisk or HomePage. 

Your computer comes with iMovie optimized for Mac OS 9 and Mac OS X.

To Get Started

1 Shoot your video, then connect the camera to your computer’s FireWire port.

2 Open iMovie in the iMovie folder (located in the Applications folder).

3 Click the Import button to import movie clips to the shelf, then add them to your movie by 
dragging them to the clip viewer.

4 Assemble and edit your movie in the clip viewer and timeline viewer.

5 Add transitions, titles, sound, and music.

6 When you are finished, choose Export from the File menu.

Tips and Tricks

Share your desktop iMovie with your friends and family

Export your movie as a QuickTime Web movie and copy the movie to your iDisk. 
Then use HomePage to create your own iMovie theater so that others can view your movie 
on the Internet.

To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the 
latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible 
DV camcorders, go to the iMovie Web site at www.apple.com/imovie 
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iTunes—Digital Music For Your Mac

Eject CD 
button

Radio TunerC

Listen to hundreds
of Internet radio 

stations—jazz, rock, 
talk, and more.

Audio CDsC

Play an audio CD 
on your computer. 

Import songs to 
your library.

Portable musicC

Transfer songs to 
an MP3 player by 

dragging songs 
from your library.

New Playlist buttonC

Create a personalized 
playlist using songs 
from your library.

SearchC

Type some text 
and iTunes lists 
song titles 
that match.

Visuals buttonC

Have iTunes display
 a stunning light show that 

changes, throbs, and pulses
to the beat of your music. 
Enjoy different colors and 

patterns every time you
listen to a song.
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What You Can Do

iTunes lets you import songs from music CDs as MP3 files, create playlists, move music to 
your portable MP3 player, listen to hundreds of radio stations on the Internet, and more.

To Get Started

1 Open iTunes (located inside the Applications folder on your hard disk).

2 Insert a music CD into your PowerBook’s optical drive.

3 Click the checkbox next to the songs you want to import.

4 Click the Import button. Your songs are converted into MP3 files and stored in your iTunes 
library.

Tips and Tricks

Create playlists for your favorite sets of songs

iTunes lets you create playlists from songs in your library. A playlist is a list of songs in a 
specific order. Use your playlists to program your music for specific moods, artists, or 
themes. Click the New Playlist button and drag songs from your library to the playlist.

Resize the iTunes window or access iTunes from the Control Strip

You can collapse the iTunes window to show just the playback controls and status. Click the 
zoom box in the upper-right corner of the iTunes window. You can also access iTunes 
controls from the iTunes Control Strip module in Mac OS 9 or from the Dock in Mac OS X.

Look up CD information from CDDB

iTunes connects to the CDDB database on the Internet automatically to look up the name of 
the CD, song titles, and other information about your music CD. If you are not connected to 
the Internet, you can look up information on songs you imported the next time you connect. 
Select the song and choose Get CD Track Names from the Advanced menu.

Connect your PowerBook to your stereo system

You can easily connect your PowerBook to your stereo system. Use a miniplug-to-RCA cable 
(not included) to connect the headphone port (f) on your PowerBook to the audio input 
ports on your stereo.

To Learn More

For more information on using iTunes, see iTunes Help or go to the iTunes Web site at 
www.apple.com/itunes
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Auto Updating—Automatically Keep Your Mac on the Cutting Edge

Update NowC
Click to check instantly for updates 

available for your Apple software. Select 
the Apple software you want to update 

from the list that appears.

Update softwareC
Set how often your computer 
checks for software updates 
from Apple.
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What You Can Do

Software Update uses the Internet to download and install the latest software versions, 
drivers, and other enhancements from Apple automatically. Use Software Update to instantly 
check Apple’s Internet servers to see if any updates are available for your Apple software. You 
can even set your Mac to check the Apple server periodically and download and install 
updated software for you.

To Get Started

1 Connect to the Internet.

2 Open Software Update:

m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Software 
Update from the submenu. 

m In Mac OS X, open System Preferences and click Software Update. 

3 Click Update Now, then select the software updates you want and click Install.

Tips and Tricks

Adjust your Software Update schedule

If you have an Internet connection that is always on, you can set a schedule for your 
computer so that it checks for software updates at a certain time on specific days of the 
week. If you have a dialup connection and you are not connected, Software Update will 
check the next time you connect.

Install new software automatically

You can set up your Mac so that every week it checks for and installs the latest software. Set a 
schedule for your computer to check for software updates and deselect the “Ask me before 
downloading new software” checkbox. 

To Learn More

For more information on using Software Update, search for “Software Update” in 
Mac Help. For the latest information on the Mac OS, go to the Mac OS Web site at 
www.apple.com/macos 
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Multiple Users—Turn One Mac Into Many

UsersC
Use the Users pane in 
System Preferences to 
add user accounts.

Shared FolderC
To give access to the 

Shared folder, a user can 
turn on file sharing in 
Sharing preferences.

HomeC
Each user has a home. 

Finder, Dock, iTools, 
Mail, and other 

preferences are kept for 
each user in the user’s 

home, so users can 
customize Mac OS X 

the way they want.
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What You Can Do

Several people can share a single computer by logging in to their individual user accounts. 
Users can select their own customized settings, such as bookmark and desktop views, and 
access their own private storage space, called a Home folder. Users sharing the computer 
also have access to a common Shared folder.

The first user account created on your computer is designated an administrator. 
Administrators are users with special privileges: they can give new users access to the 
computer, install software, and change general computer settings. 

Note:  If you forget the administrator password, you can reset it using the Mac OS X CD. 
Start up from the Mac OS X CD and choose Reset Password from the Installer menu. Because 
a user with the Mac OS X CD can gain unrestricted access to the computer, you should keep 
the CD in a safe place.

To Get Started

1 Create a new user:

m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Multiple 
Users from the submenu. Turn on Multiple User Accounts, then click New User.

m In Mac OS X, choose System Preferences from the Apple (K) menu, click Users, then 
click New User. 

2 Edit the user’s information. You can give a user administrative privileges.

3 Close the window.

Tips and Tricks

Keeping your computer secure

You can require a password to access the computer after the screen saver appears in case 
users log in and leave the computer unattended. Open System Preferences, click Screen 
Saver, and click Activation to select the period of inactivity before the screen saver starts. 
Then select “Use my user account password.” 

Set up user privileges

In Mac OS 9, administrators can specify the documents and applications that users can access 
and configure overall settings such as a Welcome message and the default desktop 
environment. For details, search for “Multiple Users” in Mac Help in Mac OS 9.

To Learn More

For more information on setting up user accounts in Mac OS X, search for “users” in 
Mac Help. 
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Mac Help—Answers to All Your Macintosh Questions

SearchC

Got a question?
Type it here and 

click Ask.
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C H A P T E R

3

3 Using Your Computer

Your PowerBook has many built-in features and expansion capabilities you can use to 
customize and expand your computer to fit your needs. These include the following:

m Universal Serial Bus (USB) for connecting additional equipment to your PowerBook, 
such as printers, scanners, joysticks, keyboards, digital cameras, and floppy disk drives.

m FireWire for connecting high-speed equipment, such as digital video cameras and 
external hard disks.

m The latest in communications technologies, such as a 56K modem, infrared,
10/100/1000Base-T Ethernet, and AirPort wireless Internet and networking. 

m The ability to use your PowerBook with an external monitor, video projector, or 
television, including support for video mirroring and creating an extended desktop. 
Use your PowerBook’s built-in video support to do presentations, work with an 
external monitor, or play DVD-Video discs on your television.

m A long-lasting battery, one Type II PC Card/CardBus slot, and more.

To learn about what you can do with your PowerBook, start with the information in this 
chapter. Additional information can be found in Mac Help (see page 42) and on the many 
Apple Internet Web sites.
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Universal Serial Bus (USB)

Your PowerBook comes with two USB ports, which you can use to connect many types of 
external devices, including printers, scanners, digital cameras, game pads, joysticks, 
keyboards, and floppy disk drives. USB makes it easy to connect external equipment. In most 
cases you can connect and disconnect a USB device while the computer is running. Once you 
connect the device, it is ready to use. You don’t need to restart or reconfigure your computer.

Using USB Devices

To use a USB device with your computer, simply connect the device to the computer. Your 
computer automatically loads the correct software whenever you attach a new device. 

Note:  Apple has already included software to work with many USB devices. When you 
connect a USB device, if your PowerBook cannot find the correct software, you can either 
install the software that came with the device or follow the onscreen prompts to use the 
Internet to locate, download, and install the correct software.

USB Devices and Battery Power

USB devices, such as joysticks and keyboards, that get power from the USB connection 
instead of a separate power adapter can be used with your PowerBook. However, these types 
of USB devices can cause your PowerBook battery to become depleted faster. If you are 
going to have a device connected for an extended period, it is a good idea to plug in the 
power adapter.

1 2
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Using Multiple USB Devices at the Same Time

Your PowerBook has two USB ports. If you want to use more than one device on the same 
USB port, purchase a USB hub. The USB hub connects to an open port on your computer 
and provides additional USB ports (usually four or seven). 

For More Information on USB

Additional information on USB is available in Mac Help (see page 42). Choose Mac Help from 
the Help menu and search for “USB.” You can also find information on the Apple USB Web 
site at www.apple.com/usb

For information on USB devices available for your computer, check the Macintosh Products 
Guide at www.apple.com/guide
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FireWire

Your computer has one FireWire port. FireWire lets you easily connect and disconnect 
external high-speed devices—such as digital video (DV ) cameras, printers, scanners, and 
hard disks. You can connect and disconnect FireWire devices without restarting 
your computer. 

These are some of the things you can do with FireWire:

m Connect a digital video camera and capture, transfer, and edit high-quality video directly 
on your computer using video editing software such as iMovie.

m Connect an external FireWire hard disk drive and use it to back up data or transfer files. A 
FireWire hard disk icon appears on your desktop after you connect the drive to 
your PowerBook. 

m Start up from an external FireWire hard disk. Connect an external FireWire disk (with a 
valid System Folder installed on it) and then do the following:

m In Mac OS 9, open the Startup Disk control panel and click the FireWire disk.

m In Mac OS X, open the Startup Disk pane of System Preferences and click the
FireWire disk.

m Restart your computer.

Using FireWire Devices

To use a FireWire device with your computer, connect the device to the computer and install 
any software that came with the device. Your computer automatically senses when you attach 
a new device. 
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FireWire Devices and Battery Power

FireWire devices, such as certain external hard disks that get power from the FireWire 
connection instead of a separate power adapter can be used with your PowerBook. However, 
these types of FireWire devices can cause your PowerBook battery to become depleted faster. 
If a device will be connected for an extended period, it is a good idea to plug in the 
power adapter.

FireWire Target Disk Mode

If you want to transfer files between your PowerBook and another FireWire-equipped 
computer, or you have a problem that prevents your computer from starting up, you can use 
FireWire Target Disk Mode to connect to another computer.

To connect your PowerBook in FireWire Target Disk Mode, follow these steps:

1 Make sure that your PowerBook is shut down.

2 Use a FireWire cable with a standard 6-pin connector on each end to connect your 
PowerBook to another FireWire-equipped computer.

3 Start up your PowerBook and immediately hold down the T key. Your PowerBook display 
shows the FireWire logo, and the PowerBook internal hard disk icon appears on the desktop 
of the other computer.

4 When you are finished transferring files, drag the PowerBook hard disk icon to the Trash.

5 Press the Power button on the PowerBook to shut it down and then disconnect the 
FireWire cable.

For More Information on FireWire

Additional information on FireWire is available in Mac Help (see page 42). Choose Mac Help 
from the Help menu and search for “FireWire.” You can also find information on the Apple 
FireWire Web site at www.apple.com/firewire

Note:  The FireWire port is designed to support power for FireWire devices (up to 7 watts 
maximum). You can connect multiple devices to each other and connect the “daisy-chain” of 
devices to the FireWire port on your computer, but only one device should get power from 
the computer. The rest of the devices in the daisy-chain should be powered by separate 
power adapters. Connecting more than one FireWire device that gets power from the 
computer may cause problems. If a problem occurs, shut down the computer, remove the 
FireWire devices, and restart your computer.

Important  The computer you connect your PowerBook to must have FireWire version 2.3.3 
or later installed. Use Apple System Profiler, available in the Apple menu in Mac OS 9 and in 
the Utilities folder in the Applications folder in Mac OS X, to check the version of FireWire 
installed on your computer.
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PC Cards

You can expand your computer’s capabilities using the PC Card slot. Your PowerBook has 
one PC Card slot that accepts Type I and Type II PCMCIA cards, including CardBus-format 
cards. You can insert a PC Card when your computer is on, off, or in sleep.

 

Inserting and Ejecting a PC Card

When inserting a PC Card, make sure the label is facing up and the card is level. You’ll feel 
some resistance as you slide the card in. When the card is firmly seated in the slot, it clicks 
into place and an icon appears on the desktop. You can eject a PC Card when your computer 
is on or off, but not when it is in sleep.

To eject a PC Card:

1 If the computer is turned on, drag the card’s icon to the Trash.

2 Push the PC Card eject button once to release the button.

3 Push the button again to eject the card.

4 Pull the card out of the slot and then push the eject button again to set it flush against 
the computer.

For More Information on PC Cards

For information on the PC Cards available for your PowerBook, check out the Macintosh 
Products Guide at www.apple.com/guide
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PC Card slot

Eject button

Important  The Apple AirPort Card is installed in a slot inside your computer. It does not go 
in the PC Card slot the way many third-party wireless cards do. The AirPort Card will not work 
if it is installed in the PC Card slot and will cause your computer to function improperly.
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AirPort Wireless Internet and Networking

Your PowerBook is AirPort-ready. It has a built-in antenna, and an AirPort Card may already be 
installed in it. AirPort offers an easy and affordable way to provide wireless Internet access 
anywhere in the home, at work, or in the classroom. Instead of using traditional cables, 
AirPort uses wireless local area network (LAN) technology to provide wireless 
communication between multiple computers. Through a wireless network you can set up 
access to the Internet, transfer files, play multiplayer games, and more.

Note:  Wireless Internet access requires an AirPort Card, AirPort Base Station, and Internet 
access (fees may apply). Some Internet service providers are not currently compatible with 
AirPort, including America Online. Range may vary with site conditions.

How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a base station, which has 
a physical connection to the Internet. AirPort technology works like a cordless telephone. 
The AirPort Card in the computer makes a wireless connection to the base, which is 
connected to the telephone line.

For More Information on AirPort

To purchase an AirPort Base Station, contact your Apple-authorized dealer or go to the Apple 
Store at www.apple.com/store

Additional information on AirPort is available in AirPort Help. Choose Help Center from the 
Help menu and click the AirPort Help link. You can also find information on the Apple 
AirPort Web site at www.apple.com/airport

AirPort Base Station

Connection to the Internet  

AC outlet  

®
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Ethernet (10/100/1000Base-T)

Your computer comes with built-in 10/100/1000 megabit per second (Mbps) twisted-pair 
Ethernet networking capability, which you can use to connect to a network or to a cable or 
DSL modem.

Connecting to a network gives you access to other computers. You may be able to store and 
retrieve information, use network printers, modems, and electronic mail, or connect to the 
Internet. You can also use Ethernet to share files between two computers or set up a small 
network. The Ethernet port on your PowerBook auto-detects other Ethernet devices. You 
don’t need an Ethernet crossover cable when connecting to other Ethernet devices.

m Use 2-pair category 3 Ethernet cables to connect to a 10Base-T Ethernet network.

m Use 2-pair category 5 Ethernet cables to connect to a 100Base-T Ethernet network.

m Use 4-pair category 5 Ethernet cables to connect to a 1000Base-T Ethernet network.

For More Information on Using Ethernet

Additional information, including setting up an Ethernet network and transferring files using 
Ethernet, is available in Mac Help (see page 42). Choose Mac Help from the Help menu and 
search for “Ethernet” or “network.” 

For information on networking products you can use with your PowerBook, check the 
Macintosh Products Guide at www.apple.com/guide
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Infrared (IrDA)

Because your PowerBook is equipped with infrared (IR), you can exchange files and data 
without using wires. The type of IR used is the industry-standard IR communication method 
known as IrDA.

You can use infrared to share files with another IrDA-equipped computer, communicate with 
other infrared devices such as handheld organizers, connect to an infrared network, and 
even print on an infrared printer. Sharing files using infrared is the same as sharing files using 
Ethernet, except that AppleTalk and TCP/IP are set to Infrared instead of Ethernet. File 
sharing and IrDA printing are not supported in Mac OS X.

Note:  You cannot share files with a computer that only supports IRTalk (a non-standard IR 
communication method used by some older computers).

Making an Infrared Connection

To connect to another computer using infrared:

1 Position the IR windows of the two computers so that they are directly facing and within one 
meter of each other.

2 Configure AppleTalk and TCP/IP to communicate using infrared.

3 Make sure that file sharing is turned on in the File Sharing control panel in Mac OS 9.

For More Information on Infrared

Information on configuring the Mac OS to communicate using infrared and setting up file 
sharing is available in Mac Help (see page 42). Choose Mac Help from the Help menu and 
search for “infrared” or “file sharing.”
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External Video Support (VGA and S-Video)

Your computer has a monitor port that allows you to directly connect a monitor with a
VGA-style adapter or other external video device such as a video projector. 

The TV out port (also known as an S-video out port) on your computer lets you connect to a 
television, videocassette recorder ( VCR), or video projection system using either an S-video 
or composite video cable (available at your local electronics store). You can use TV out to 
display images on a television, record computer images on a VCR, or play DVD-Video discs 
on your television. 

If the device you want to connect does not have S-Video, you can use the Composite-to-S-video 
adapter that came with your PowerBook. 

When an external monitor or television is connected, you can either have the same image 
appear on both the internal display and the external monitor (known as video mirroring) or 
use the external monitor to extend the size of the Mac OS desktop (known as extended 
desktop mode).

Note:  Because of the display limitations of most televisions, images displayed on the television 
screen will be of lower quality than those on the built-in display or an external monitor.
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Connecting an External Monitor

To connect an external monitor to your computer:

1 Turn off the external monitor.

2 Connect the monitor cable to your PowerBook.

3 Turn on the external monitor.

4 Hold down the Command (x) key and press the Brightness up/F2 key ( ) to auto-detect 
the new monitor.

5 Adjust the resolution on the external monitor:

m In Mac OS 9, click the Resolution portion of the Control Strip. To see a list of all possible 
resolutions, press the Control key when you click Resolution.

m In Mac OS X, click the Display tab on the Displays pane of System Preferences or use the 
Displays icon in the menu bar.

For information on the supported external monitor resolutions, see “External Monitor in 
Extended Desktop or Video Mirroring Mode” on page 97.

To display the same image on the PowerBook display and an external monitor, turn Video 
Mirroring on in the Control Strip in Mac OS 9 or with the Display icon in the menu bar in 
Mac OS X. You can switch between video mirroring and extended desktop mode by pressing 
the Command (x) key and the Brightness down/F1 key ( ).

Important  For optimal mirroring performance, set the built-in display and the external 
monitor to the same resolution and color depth. 

Using Your PowerBook With the Display Closed

You can use your PowerBook with the display closed if the computer is connected to an 
external monitor, keyboard, mouse, and the power adapter. 

To operate your computer with an external monitor attached and the display closed, do the 
following:

1 Connect a USB keyboard and mouse to your PowerBook.

2 Close the PowerBook display to put the computer to sleep.

3 Follow the steps in the previous section to connect your PowerBook to an external monitor.

4 Wait a few seconds and then press any key on the external keyboard to wake the PowerBook.

Video MirroringColor Depth Resolution
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Connecting a Television, VCR, or Other Video Device

To connect a device to the TV out port:

1 Connect an S-video cable to the TV out port (Æ) on your PowerBook (or use the adapter to 
connect a composite video cable) and connect the other end to your device.

2 If you want to send the sound from your PowerBook to the device, connect a miniplug-to-
RCA cable (not included) from the headphone port (f) on your PowerBook to the audio 
input ports on your device.

3 Turn on the external device.

4 Hold down the Command (x) key and press the Brightness up/F2 key ( ) to auto-detect 
the TV monitor.

5 Adjust how the images are displayed on the device:

m In Mac OS 9, use TV Mirroring in the Control Strip. 

m In Mac OS X, use the Displays pane of System Preferences.

For More Information on Using an External Monitor or TV

Additional information on using and configuring an external monitor is available in Mac Help 
(see page 42). Choose Mac Help from the Help menu and search for “monitor.” 

TV Mirroring
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Battery 

When the external power adapter is not connected, your computer draws power from its 
battery. You can determine the charge left in your battery by looking at the battery level 
indicator lights on the battery itself. The lights glow to show how much charge is left in the 
battery. The indicator lights remain lit for a few seconds after you press the button. You can 
check the charge with the battery in or out of your PowerBook.

Removing and Replacing the Battery

To remove the battery:

m Shut down your PowerBook or put it to sleep. Turn it over and locate the battery release 
latch. Slide the latch to the side and gently remove the battery.

Important  If only one flashing light is on, very little charge is left. If no lights are visible, the 
battery is completely drained and the computer will not start up unless the power adapter is 
connected. Plug in the power adapter for several hours to let the battery recharge.

Battery

Battery LEDs

Battery

Latch
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Swapping Batteries While the Computer Is in Sleep

If your battery runs low while you are working, you can put your PowerBook to sleep and 
replace the battery with a charged one. The internal backup battery provides enough power 
to maintain the contents of RAM for three minutes while you change the battery.

Charging a Battery

When the power adapter is connected, the battery is recharged whether the computer is off, 
on, or in sleep. A light appears on the power adapter plug. An amber light indicates that the 
battery is being charged. A green light indicates that the battery is fully charged.

The battery will recharge more quickly if the computer is off or in sleep. You can monitor the 
battery charge level.

m In Mac OS 9, use the battery charge level indicator in the Control Strip.

m In Mac OS X, use the battery icon in the menu bar.

To maximize the life of your PowerBook battery, use the power adapter whenever possible.

Calibrating a New Battery for Best Performance

To get the longest running time from a new PowerBook battery, let the battery run down 
during the first week of use and then fully charge it one time. Follow these steps:

1 Plug in the power adapter and fully charge your PowerBook battery until the battery 
indicator lights and the onscreen meter indicate that the battery is fully charged.

2 Disconnect the power adapter and use your PowerBook until you see the first low 
battery warning dialog box on your screen.

3 Connect the power adapter and leave it connected until the battery is fully charged again.

Battery charge level indicator

Important  You only have to fully discharge and then charge your battery once to calibrate 
it. After that, you can connect and disconnect the power adapter when the battery is at any 
charge level.
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Battery-Conservation Tips

The amount of work time your PowerBook battery can provide before you need to recharge 
it depends on the equipment you’re using with your computer and the steps you take to 
conserve power while you work. 

To conserve battery power, do one or more of the following:

m Disconnect bus-powered USB or FireWire devices when they are not in use.

m Quit open applications that you are not using.

m Remove CD-ROM and DVD-ROM discs when they are not in use.

m Reduce screen brightness using the brightness controls on the PowerBook keyboard.

m Put the computer in sleep whenever your work is interrupted.

m In Mac OS 9, select “Turn off the built-in display instead of dimming it” on the Advanced 
Settings tab of the Energy Saver control panel 

You can also:

m Set the hard disk to spin down after a short time. 

m Set your PowerBook to sleep after inactivity of five minutes or less. 

To access your computer’s energy settings:

m In Mac OS 9, use Energy Settings in the Control Strip. 

m In Mac OS X, use the Energy Saver pane of System Preferences.

For More Information on Your PowerBook Battery

Additional information is available in Mac Help (see page 42). Choose Mac Help from the 
Help menu and search for “battery.”
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DVD-ROM Drive 

All the software necessary to use your computer and connect to the Internet is already 
installed on your PowerBook. ( You need to use the PowerBook CDs that came with your 
computer only if you are having problems and need to reinstall system software.) However, if 
you purchased additional software with your PowerBook, you can install or run programs 
from CD and DVD discs using the optical DVD-ROM drive.

Note:  If you have older software that comes on floppy disks, contact the software 
manufacturer to see if the software is available on a CD-ROM disc or purchase a third-party 
external floppy disk drive (such as an LS120/SuperDisk) from your Apple dealer or 
the Apple Store (www.apple.com/store).

Inserting a CD or DVD Disc

To install or use programs from a CD or DVD disc, follow these steps:

1 With the computer turned on, insert the disc (with the label facing up) into the drive slot 
until you feel the drive catch the disc and take it the rest of the way in.

2 When the icon for the disc appears on the desktop, the disc is ready to use.

®

Emergency
eject hole

Paper clip

Important  Your PowerBook’s optical DVD-ROM drive supports standard circular 12 cm
and 8 cm discs. Irregularly shaped discs and discs smaller than 8 cm are not supported. 
Non-circular discs may become lodged in the drive.
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Ejecting a Disc

You eject a disc by dragging the disc icon to the Trash or pressing and holding the Media 
Eject ( ) key on the keyboard. 

If you can’t eject the disc, try the following:

m Quit any applications that may be using the disc and try again.

m Restart your computer and hold down the trackpad button during startup until the disc 
ejects.

m If that does not work, insert the end of a paper clip into the manual eject hole (located on 
the far right side of the drive slot on the DVD-ROM drive) to press the internal eject 
button. Your PowerBook must be turned on.

Playing DVD Discs

You can also use the DVD drive to play DVD-Video discs on your PowerBook. Insert the
DVD disc and do the following:

m In Mac OS 9, choose Apple DVD Player from the Apple (K) menu.

m In Mac OS X, use the Apple DVD Player application, located in the Applications folder on 
your hard disk.

If you use S-video to connect your PowerBook to a TV (see page 52) so that you can watch a 
DVD-Video on the TV screen, select 720 x 480 NTSC (in the United States) or 720 x 576 PAL 
(in Europe and other regions).

m In Mac OS 9, use the Resolution portion of the Control Strip.

m In Mac OS X, use the Display tab of the Displays pane of System Preferences.

Note:  When your PowerBook is connected to an external monitor, DVD playback is only 
available in extended desktop mode. You can’t use video mirroring for DVD playback. 

You can easily connect your PowerBook to your stereo system. Use a miniplug-to-RCA cable 
(not included) to connect the headphone port (f) on your PowerBook to the audio input 
ports on your stereo.

For More Information on Your DVD Drive

For instructions on using Apple DVD Player, open the player and then choose Apple DVD 
Player Help from the Help menu.
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Optional CD-RW Drive

If your PowerBook came with a CD-RW drive, you can record your favorite music, programs, 
and files on CD-R and CD-RW discs. You can create your own music CDs and play them on 
any standard audio player. You can also record computer files, such as applications, 
documents, or other digital files, on a recordable CD. 

With a CD-R (CD-Recordable) disc you can record information on the disc once. Although 
you can’t change the recorded information, you may be able to add more information until 
the disc is full, depending on the application you use. See the documentation that came 
with your application for specific information about recording on your CD-R disc. It is best 
to use CD-R discs for recording audio CDs, because most audio CD players cannot read 
CD-RW discs.

With a CD-RW (CD-Rewritable) disc you can save and change information on your CD 
multiple times. However, some software for recording media files on CDs, such as the iTunes 
Disc Burner feature, can record data on the disc only once.

Inserting a CD Disc

To install or use programs from a CD disc, follow these steps:

1 With the computer turned on, insert the disc (with the label facing up) into the drive slot 
until you feel the drive catch the disc and take it the rest of the way in.

2 When the icon for the disc appears on the desktop, the disc is ready to use.

For information about how to use iTunes to record music files on a CD, see the online help 
for iTunes in the Help Center.

Ejecting a Disc

You eject a disc by dragging the disc icon to the Trash or pressing and holding the Media 
Eject ( ) key on the keyboard. 

If you can’t eject the disc, try the following:

m Quit any applications that may be using the disc and try again.

m Restart your computer and hold down the trackpad button during startup until the 
disc ejects.

Important  Your PowerBook’s optical CD-RW drive supports standard circular 12 cm discs. 
Irregularly shaped discs and discs smaller than 12 cm are not supported. Non-circular discs 
may become lodged in the drive.
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Keyboard Controls and Programmable Function Keys

You can quickly adjust settings such as volume and screen brightness and eject a CD or DVD 
disc using the keyboard controls.

Your PowerBook also has five additional keys that you can set up to open your frequently 
used applications or documents in Mac OS 9. These keys are known as programmable 
(or hot) function keys. For example, you can use these keys to open your Web browser, 
word processor, or favorite game. Once applications are open, you can use the keys to 
switch quickly between them.

Assigning Programmable Function Keys

In Mac OS 9, the first time you press one of the function keys, a dialog box appears that lets 
you assign any of the function keys to an application. After that, you can change function key 
assignments using the Keyboard control panel.

Using the Standard Function Keys

You can quickly change a key from a control or programmable function key to a standard 
function key by pressing the Fn key while you press the other key. You can also use the 
Keyboard control panel in Mac OS 9 to reverse the keys so that the standard function keys 
are primary and the screen controls and programmable function keys are secondary. ( You 
would hold down the Fn key to change the screen brightness, for example.) In Mac OS X,
use the Keyboard pane of System Preferences to control the function keys.

®

¤ Brightness
     controls

- Volume
     controls Hot function keys

Media Eject key

Function (Fn) key
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Using the Embedded Numeric Keypad

Most desktop computer keyboards have a numeric keypad in addition to the regular 
keyboard keys. Your PowerBook keyboard has a numeric keypad incorporated in the 
standard keyboard keys. Keys used for the numeric keypad have a smaller secondary label.

To use the numeric keypad, press the Num Lock key on the keyboard. The light next to the 
Num Lock key turns on, indicating that the keypad is active. When you’re finished, press the 
Num Lock key again to turn it off. 

Note:  When the numeric keypad is active, other keys and keyboard equivalents for menu 
commands (such as x-Q to quit) are deactivated.

For More Information on Keyboard Controls

Additional information on configuring the keyboard controls and programmable function 
keys is available in Mac Help (see page 42). Choose Mac Help from the Help menu and 
search for “keyboard.”

®

Numeric keypad

Num Lock key
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Security Slot and Keyboard Lock

You can purchase a security cable and lock to protect your PowerBook. With a lock, you can 
secure your computer to a desk or table. 

Your PowerBook also comes with a keyboard locking mechanism. When the keyboard lock is 
engaged, the keyboard can’t be flipped up for access to the internal components of the 
computer, including the memory.

The keyboard locking mechanism is in the small plastic tab to the left of the Num Lock 
key, which also contains the Num Lock indicator light. Your PowerBook comes with the 
keyboard unlocked.

To lock the keyboard, use a small flathead screwdriver to the turn the screw clockwise 1/2 
turn. A small tab prevents the keyboard from being removed.

Note:  The screw that turns the plastic tab has a small notch on one side that you can use to 
determine if the keyboard is locked. If the notch in the screw is on the top, the keyboard is 
unlocked. If the notch in the screw is on the bottom, the keyboard is locked.

For More Information on Security Options

Additional information on the software security features of your PowerBook, including 
multiple user passwords and file encryption, is available in Mac Help (see page 42). Choose 
Mac Help from the Help menu and search for “security” or “multiple users.”

Note:  If you are using Mac OS 9, the Password Security control panel used on older 
computers is not compatible with your PowerBook and is not installed on your computer.

®

Sample locking device
with security cable

Security slot
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4 Working With Your Operating System

An operating system, or OS, is your computer’s desktop environment that defines how the 
items on your desktop are represented and how you interact with them. Each OS has a 
different look and feel. 

Your computer comes with Mac OS 9 installed as the default operating system. The first
time you start your computer, it starts up using Mac OS 9. Your computer also comes with 
Mac OS X and Classic, a technology that allows you to use Mac OS 9 applications inside
Mac OS X.

Some software applications have not yet been optimized to work with Mac OS X or Classic. 
They perform best in Mac OS 9. If you use only Mac OS 9–compatible software and do not 
need the special features of Mac OS X, continue to start up your computer in Mac OS 9. This 
chapter describes some of the features of Mac OS X and Classic and how to switch your OS.
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About Mac OS X

Start up using Mac OS X and explore its advanced technologies, such as the elegant new 
user interface, incredible graphics capabilities, and added system stability and performance. 
Mac OS X manages your computer processes so you can concentrate on what you want to 
do. You don’t need to worry about restarting your computer if something goes wrong with 
one software application. Mac OS X shuts down just that application so you can keep 
working without interruption. The Mac OS X virtual memory manager allots the amount of 
memory your software applications need to run efficiently. When you’re ready to learn 
more about Mac OS X, read Welcome to Mac OS X. This book introduces the features of 
Mac OS X and provides tips for Mac OS 9 users on how to use Mac OS X to perform 
common Mac OS 9 tasks. If you experience any problems while learning about Mac OS X, 
see the Troubleshooting tips in the back of the book or choose Mac Help from the Help 
menu in Mac OS X. 

Information About Software and Mac OS X

For information about the compatibility of software applications with Mac OS X, or to read 
more about Mac OS X, check the Apple Web site: guide.apple.com/macosx/

Using Classic in Mac OS X

In addition to using Mac OS X applications, you can continue to use Mac OS 9 applications in 
the special Classic environment. Classic works in the background to access Mac OS 9 features 
and software applications. When you start up Classic, Mac OS 9 software works in Mac OS X 
just as it does in Mac OS 9, but doesn’t benefit from Mac OS X features such as the look of 
the new interface. Simply open a Mac OS 9 application or double-click a document created in 
a Mac OS 9 application. If Classic isn’t running, it starts up.

Classic continues to run in the background, even if no Mac OS 9 applications are open, so 
applications and documents open faster and more easily. You can set your computer to start 
up Classic automatically when you log in to Mac OS X. Choose System Preferences from the 
Apple (K) menu, click Classic, and select “Start up Classic on login to this computer.”

To quit the Classic environment, click Stop in the Classic pane of System Preferences. You can 
save any unsaved changes to your Classic documents and quit Classic.

Important   Because Mac OS X is already installed on your computer, you don’t need to 
follow the installation instructions in Welcome to Mac OS X. Instead, follow the instructions 
in Welcome to Mac OS X to log in and begin using Mac OS X.

Important  Do not remove the Mac OS 9 operating system from your computer. For Classic 
to work, Mac OS 9 must be installed.
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Switching Between Operating Systems

Your computer is set to use Mac OS 9. You can switch between Mac OS 9 and Mac OS X. 
Once you’ve set your computer to use OS X, it will always start up using OS X until you set it 
to use Mac OS 9.

To set your computer to start up using Mac OS X: 

1 In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Startup Disk.

2 In the Startup Disk control panel, double-click the hard disk that contains your operating 
systems and select the Mac OS X System folder as your startup disk. You can click the 
triangle to the left of the hard disk icon to see the System folders installed on it.

Restart your computer.

Note:  Because Apple frequently releases new versions and updates to its system software, 
the version number of the Mac OS X and Mac OS 9 operating systems in this manual may be 
different from those installed on your computer.
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To set your computer to start up using Mac OS 9: 

1 Choose System Preferences from the Apple (K) menu and click Startup Disk. 

2 Select the Mac OS 9 folder as your startup System Folder. (If the icons are dimmed, click the 
lock icon at the bottom of the pane and type the user name and password that you created 
previously in the Setup Assistant. See Welcome to Mac OS X for more information about 
logging in as an administrator.) 

3 Restart your computer.

Some tasks and software applications require your computer to start up using Mac OS 9. You 
can change the Mac OS your computer uses as often as you like.

Need Help?

For more information about the features of your Macintosh, choose Mac Help from the Help 
menu and click any of the blue underlined text. You can also type a question in the Search 
field and press Return on the keyboard. 
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5 Working Inside Your Computer

This chapter provides information and instructions for working inside your computer. 

Instructions are provided for the following procedures:

m “Installing Additional Memory” on page 69

m “Removing the Internal Hard Disk” on page 78

m “Installing an AirPort Card” on page 87  

Installing Additional Memory

Your computer comes with two memory slots, one above the other, that you access by 
removing your PowerBook keyboard. Your computer comes with a 128 megabyte (MB) 
Synchronous Dynamic Random-Access Memory (SDRAM) module installed in the lower slot. 
The upper memory slot can accept a SDRAM module that meets the following specifications:

m Small Outline-Dual Inline Memory Module (SO-DIMM) format

m 1.25 inch or smaller

m 64, 128, 256, or 512 MB

m 144-pin

m PC-133 Type RAM

SDRAM from an earlier PowerBook that meets these specifications can be used with
your PowerBook.

The maximum amount of RAM you can install in your PowerBook is 1 GB, using 512 MB 
DIMMs in both the upper and lower RAM slots.

Warning  Apple recommends that you have an Apple-certified technician install memory 
or remove the internal hard disk. Consult the service and support information that came 
with your computer for instructions on how to contact Apple for service. If you attempt 
any of these procedures and damage your equipment, such damage is not covered by the 
limited warranty on your computer.
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Installing Additional RAM

1 Shut down your computer. Disconnect the power adapter, phone cord, and any other cables 
connected to the computer.

2 Flip the computer over and remove the battery.

This prevents you from accidentally turning on the computer while installing memory.

Battery

Latch

Warning  The internal components of your PowerBook may be hot. If you have been 
using your PowerBook, wait 30 minutes after shutting down your computer to let the 
internal components cool down before continuing.
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3 Make sure that the keyboard locking screw is not in the locked position. Your new 
PowerBook comes with the keyboard unlocked, so unless you or someone else locked the 
keyboard, you can skip this step.

4 Release the keyboard by pulling down on the keyboard release tabs (located to the left of the 
F1 and F9 keys) and then lift the top portion of the keyboard.

®

®
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5 Lift the top portion of the PowerBook keyboard up slightly near the top row of keys and pull 
it back far enough to displace the small tabs that hold the bottom of the keyboard in place.

6 Flip the keyboard over and lay it on the palm rests and trackpad.

7 Touch a metal surface inside the computer to discharge any static electricity.

®

®
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8 Locate the upper RAM expansion slot.

9 Hold the RAM expansion card at a 30-degree angle. Line up the notch in the card with the small 
tab in the RAM expansion slot. Then push the RAM expansion card into the expansion slot.

You may feel some resistance. If you are having trouble inserting the card, try pushing one 
side at a time.

®

Upper
RAM
slot

Lower
RAM
slot (filled)

®

Insert RAM expansion
card at a 30o angle 

30O
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10 Gently push the RAM expansion card down until the two snaps on either side of the card 
lock into place.

11 Flip the keyboard back on top of the opening in your PowerBook and insert the small tabs at 
the bottom of the keyboard into the openings in the PowerBook case.

®

®
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12 Pull down on the keyboard release tabs (located to the left of the F1 and F9 keys) and then 
press down on the top portion of the keyboard.

13 Let go of the keyboard release tabs to secure the keyboard in place.

14 Turn the PowerBook over and replace the battery.

15 Reconnect the power adapter and any other cables that were attached.

®
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Making Sure Your Computer Recognizes the New Memory

After installing additional memory in your PowerBook, check whether the computer 
recognizes the new memory. Do the following:

1 Start up your computer.

2 When you see the Mac OS desktop, choose About This Computer from the Apple (K) menu.

In Mac OS 9

In Mac OS X

Total memory installed 
in your PowerBook

Total memory installed 
in your PowerBook
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The total includes the amount of memory that originally came with the computer plus the 
new memory you added. For a more detailed breakdown of the amount of memory installed 
in your computer, use Apple System Profiler. Under Mac OS 9, choose Apple System Profiler 
from the Apple (K) menu. Under Mac OS X, open the Applications folder, then open the 
Utilities folder, and double-click the Apple System Profiler application to open it.

If the memory is not recognized or your computer does not start up correctly, shut down 
your PowerBook and check the instructions again to make sure that the memory you 
installed is compatible with this PowerBook and that it is installed correctly. If you still have 
problems, remove the memory and consult the service and support information that came 
with your computer for instructions on how to contact Apple for service. 
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Removing the Internal Hard Disk

When the computer is shut down, you can remove the internal hard disk for maintenance or 
as a security measure.

1 Shut down your computer. Disconnect the power adapter, phone cord, and any other cables 
connected to the computer.

2 Place a towel or soft cloth on a table in front of you. 

The towel or cloth protects the keyboard and display of the PowerBook when you flip it over. 
Make sure that the towel covers an area large enough for your PowerBook and that it hangs 
over the edge of the table.

3 With the display open, carefully flip the PowerBook over and rest it on the edge of a table. 
Make sure the weight of the computer is on the table and not on the display.

Soft cloth Top of display
in your lap

Important  Do not open the display further than the angle shown above.
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4 Remove the battery by sliding the latch to the left. Make sure to return the battery latch fully 
to the right.

5 Using a Torx T-8 screwdriver, remove the eight screws that secure the bottom case of the 
PowerBook in the order shown in the illustration below.

Warning  The internal components of your PowerBook may be hot. If you have been using 
your PowerBook, wait 30 minutes after shutting down your computer to let the internal 
components cool down before continuing.

7
8

5
2

3

4
1

6
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6 Carefully slide the bottom case away from you.

7 Pivot the bottom case up as shown in the illustration below.

8 Touch a metal surface inside the computer to discharge any static electricity.

Important  Do not twist the case from side to side. Slide the bottom case forward 
completely before lifting it up. If you feel any resistance when lifting the bottom case, 
double-check to make sure the bottom case is slid all the way forward and releases from 
the optical drive slot.
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9 Disconnect the connector cable from the logic board.

10 With a Torx T-8 screwdriver, remove the two screws that secure the hard disk carrier to the 
mounting bracket and then gently remove the hard disk.

Connector cable

Screws
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Replacing the Hard Disk and Bottom Case

Follow the steps in this section to replace the hard disk.

1 Remove the screw from the top of the hard disk mounting bracket.

2 Lift the mounting bracket up and gently bend it around the first battery bay tab. The tab 
holds the bracket out of the way.

Mounting
bracket

Battery
bay tab

Screw

Warning  Lift the bracket just high enough to clear the battery bay tab. If you lift the 
bracket higher than the tab you risk damaging the bracket, and such damage is not 
covered by the limited warranty on your computer.
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3 Insert the two screws into the two rubber stoppers, and screw them into the left side of the 
drive. Then make sure that the bottom and left and right sides of the drive are covered by the 
Mylar sheath.

4 Insert the right side of the drive first, then insert the left side of the drive. Use the holes in 
the drive carrier to line up the drive with the bracket.

Screw

Rubber stopperMylar sheath
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5 Lift the mounting bracket over the battery bay tab and lower it to its original position. 
Replace the screw in the top of the mounting bracket, being careful not to overtighten it.

6 Connect the hard disk connector cable to the logic board.

Screw Mounting bracket

Connector cable
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7 Attach the bottom case to the computer and replace the eight screws in the order shown in 
the illustration below.

Line up the notches on the right and left sides of the case. Then press down slightly to 
secure the case. Make sure the seams between the bottom case and the frame are closed. 
Check the outside edges and around the battery bay. Check the alignment of the eight screw 
holes to make sure the bottom case is properly positioned.

8 Replace the battery and turn the computer over.

2
1

7
6

4

5
8

3
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9 Look at the optical drive slot to make sure that the case is properly secured. 

If a gap exists below the optical drive slot, gently pull the bottom of the optical drive slot 
toward you to secure the optical drive to the bottom case and remove the gap.

10 Reconnect the power adapter and any other cables that were attached.

®

Optical drive slot
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Installing an AirPort Card

If your computer did not come with an AirPort Card, you can purchase one from your Apple-
authorized dealer or from the Apple Store at www.apple.com/store and install it yourself or 
have it installed by an Apple-authorized service provider.

To install an AirPort Card in your PowerBook, remove the back of your computer. Follow the 
instructions in the previous section, “Removing the Internal Hard Disk” on page 78, then 
follow these steps:

1 If your AirPort Card came with the AirPort adapter, remove the metal clip and pull the AirPort 
Card from the adapter. (The adapter and metal clip are not used with your PowerBook.)

2 Touch a metal surface inside the computer to discharge any static electricity.

3 Disconnect the AirPort antenna from its holder.

4 Position the AirPort Card with the AirPort ID numbers and bar code visible and slide the card 
into the connector.

AirPort
antenna
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Make sure to slide the card all the way in until you feel that the card is securely attached to 
the connector.

5 Connect the AirPort Card to the end of the antenna cable.

Make sure that the connector on the end of the antenna cable is straight before inserting it 
into the card. When it is connected, make sure the end of the antenna cable is secured by the 
small clip shown in the illustration below.

6 Fold the plastic tab on the AirPort Card over the top of the card.

Attach the bottom case to the computer. Follow the instructions in the previous section, 
“Removing the Internal Hard Disk,” beginning on page 85.

AirPort Card

Antenna clip

Important  The plastic tab must be folded over the card. If the tab is not folded over, you 
will not be able to securely attach the bottom case to the computer.
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6 Troubleshooting

Occasionally you may have problems while working with your PowerBook. Usually it’s 
because your software isn’t properly configured or you’re using applications or software 
extensions that are not compatible with the version of the Mac OS (system software) 
installed on your computer. Other less likely sources include problems with the Mac OS 
(usually fixed by reinstalling your computer’s system software or through a software update) 
and problems with your computer’s hardware, such as the memory or hard disk.

When you experience a problem with your computer, it is important to remember that there 
is usually a simple and quick solution. When you encounter a problem, be aware of the 
conditions that led up to the problem. Making a note of things you did before the problem 
occurred will help you narrow down the possible causes of the problem and then find the 
answers you need. Things to note include

m the applications you were using when the problem occurred (Problems that occur only 
with a specific application may indicate that the application is not compatible with the 
version of the Mac OS installed on your computer.)

m any software that you recently installed, especially any software that may have added 
items to the System Folder (Certain applications install extensions that may not be 
compatible with the version of the Mac OS installed on your computer.)

m any new hardware (such as additional memory or a peripheral) that you installed

Information in This Chapter

This chapter contains solutions to problems that prevent you from working with your 
computer, such as a system freeze or a computer that will not start up. You can find more 
troubleshooting information in Mac Help (see page 42) and on the Apple Support Web site
at www.apple.com/support
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Problems That Prevent You From Using Your Computer

If the computer won’t respond or the pointer won’t move

m Press the Command (x) and period keys at the same time and, if a dialog box appears, 
click Cancel. 

m If that doesn’t work, hold down the Option and Command (x) keys and then press the 
Esc key. If a dialog box appears, click Force Quit. Then save your work in any open 
applications and restart the computer to be sure the problem is entirely cleared up.

m If you are unable to force the application to quit, press and hold the Power button (®) 
for a few seconds to shut down the computer.

m If the computer still doesn’t respond, try to restart it by simultaneously pressing the 
Command (x) and Control keys on your keyboard and the Power button (®).

m If that doesn’t work, locate the reset button (see page 20) on the back panel of your 
computer. Use the end of a paper clip to carefully press the button. Make sure the 
button returns to its original position, then press the Power button (®) to restart your 
computer. 

You may need to reset the date and time (using the Date & Time control panel in Mac OS 9 
or the Date & Time pane of System Preferences in Mac OS X) after you use the reset button.

If the problem occurs frequently, choose Mac Help from the Help menu. Look at the section 
on how to prevent and solve problems. You may need to check for extension conflicts or 
reinstall your computer’s system software. If the problem occurs only when you use a 
particular program, check with the program’s manufacturer to see if it is compatible with 
your computer.

If the computer freezes during startup or you see a flashing question mark

m In Mac OS 9, turn off your system extensions by starting up your computer while holding 
down the Shift key.

Mac OS X does not use system extensions. To turn off extensions in Classic, do the following:

m In Mac OS X, select Turn Off Extensions from the pop-up menu on the Advanced tab of 
Classic pane of System Preferences. Click Restart Classic.

m If that does not work, start up your PowerBook while holding down the C key and at the 
same time insert your Mac OS 9 or Mac OS X system software CD. (Make sure the Caps 
Lock key is not engaged.)

After the computer starts up, choose Mac Help from the Help menu. Look at the section on 
how to prevent and solve problems. You may need to check for extension conflicts or 
reinstall your computer’s system software. 

If using your system software CD is the only way you can start up your PowerBook, you need 
to reinstall your computer’s system software. For instructions, look in Mac Help or open the 
software installation or restore program and follow the onscreen instructions.
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If the computer won’t turn on or start up

m Make sure the power adapter is plugged into the computer and into a functioning 
power outlet. 

m Your battery may need to be recharged. Press the small button on the battery (see 
page 55). You should see one to four lights indicating the battery’s level of charge.

m If that does not work, locate the reset button (see page 20) on the back panel of your 
computer. Carefully press the button using the tip of a pen. Make sure the button 
releases after you have pressed it.

Note:  You may need to reset the date and time (using the Date & Time control panel in 
Mac OS 9 or the Date & Time pane of System Preferences in Mac OS X) after you use the 
reset button.

m If that does not work, press the Power button (®) and immediately hold down the 
Command (x), Option, P, and R keys until you hear the startup sound a second time. 

m If you recently installed additional memory, make sure that it is correctly installed and 
that it is compatible with your computer. See whether removing it allows the computer to 
start up.

m If you are still unable to start up your computer, see the service and support information 
that came with your PowerBook for information on contacting Apple for service.
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Restoring Your Computer Software

Apple Software Restore completely erases the contents of your hard disk or partition and 
restores the original contents, including the original system software, factory settings, and 
applications that came with your computer

Should you need to restore your computer software, use the Apple software restore CDs that 
came with your computer. First back up essential software and files, if possible

Note:  If you don’t want to erase the contents of your hard disk, you can reinstall just the 
system software or certain applications using the software install CDs or application CDs that 
came with your computer. For instructions on installing Mac OS 9 and Mac OS X, see the 
Welcome to Mac OS X booklet.

1 Make sure you have all the Apple software restore CDs that came with your computer.

2 Insert the first software restore CD into your drive.

3 Restart your computer and then hold down the C key so the computer starts from the CD.

4 Follow the onscreen instructions.

The Setup Assistant opens to help you configure your computer in Mac OS 9. The first time 
you restart your computer using Mac OS X, the Setup Assistant opens to help you configure 
the Mac OS X settings. 
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Other Problems

If you have a problem with a software program

m For problems with software from a manufacturer other than Apple, contact the 
manufacturer. Often software manufacturers provide updates to their software on their 
Web sites. You can configure your PowerBook to automatically check for and install the 
latest Apple software using the Software Update control panel in Mac OS 9 or the 
Software Update pane of System Preferences in Mac OS X. For more information, choose 
Mac Help from the Help menu and search for “software update.”

If you have problems with your Internet connection

m Make sure your telephone line or network cable is connected and functioning properly.

m If you are using a dial-up Internet connection, make sure that your telephone cord is 
plugged into the modem port (marked with the icon W) and not the Ethernet port 
(marked with the icon G).

m Choose Mac Help from the Help menu. There you will find how to locate your Internet 
settings and the contact information for your Internet service provider (if you used the 
Setup Assistant to get your Internet account).

If you have a problem using your computer or working with the Mac OS

m If the answers to your questions are not in this manual, look in Mac Help for instructions 
and troubleshooting information.

m Check the Apple Support Web site at www.apple.com/support for the latest 
troubleshooting information and software updates.

If you suspect a problem with your computer hardware

m You can use the Apple Hardware Test CD to help determine if there is a problem with one 
of your computer’s components, such as the memory or processor.

Locating Your Product Serial Number

The serial number for your PowerBook is located on the inside wall of the battery bay. For 
instructions on removing the battery, see “Removing and Replacing the Battery” on page 55.
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A Specifications

This section provides basic product specifications. Additional information is available in 
Apple System Profiler on your hard disk and on the Internet at www.apple.com/powerbook 
and www.apple.com/support

Apple System Profiler

You can use Apple System Profiler to find out detailed information about your specific model 
of PowerBook, such as the amount of built-in memory, hard disk size, devices connected, 
and the product serial number.

To access the information in Apple System Profiler:

m In Mac OS 9, choose Apple System Profiler from the Apple (K) Menu.

m In Mac OS X, open Apple System Profiler, located in the Utilities folder inside the 
Application folder.

Click the triangles in the
window to show and

hide information in the
different categories.
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PowerBook Specifications

Processor, Memory, and Hard Disk

m Processor:  PowerPC G4 processor with a minimum of 550 megahertz (MHz)

m Memory:  Minimum of 128 megabytes (MB); maximum of 1 gigabyte (GB)

m Hard disk:  Minimum 20 GB 

Video Memory and Graphics

m Video memory:  16 MB DDR SDRAM

m Graphics controller:  ATI Mobility Radeon

Modem

m Modem standards:  K56flex and V.90

m Modem speed:  56 kilobits per second (Kbps)

Note:  Download speeds vary with line conditions and the modem capabilities of your 
Internet service provider (ISP). FCC regulations limit ISP transmission speeds to 53 Kbps 
in the United States.

AirPort Card

m Wireless data rate:  Up to 11 megabits per second (Mbps) 

m Range:  Up to 150 feet (45 meters) in typical indoor use (varies with building)

m Frequency band:  2.4 gigahertz (GHz)

Power Adapter

m Input:  AC 100–240 volts ( V ), 50/60 hertz (Hz)

m Output:  DC 24 V, 1.875 A

Battery

m Output:  DC 14.4 V

m Capacity:  3840 milliampere-hours (mAh)
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External Monitor in Extended Desktop or Video Mirroring Mode

With the display set to 1152 x 768 and millions of colors, an external VGA monitor supports 
the following resolutions

m Up to millions of colors:  640 x 480, 640 x 870, 800 x 600, 832 x 624, 1024 x 768,
1152 x 870, 1280 x 960, 1280 x 1024, and 1600 x 1200

m Up to thousands of colors:  1280 x 960, 1280 x 1024, 1600 x 1200, 1792 x 1344,
1856 x 1392, and 1920 x 1440

Choosing a resolution greater than 1152 x 768 in video mirroring mode causes the image on 
the external monitor to scale down (not take up the entire screen) to match the 1152 x 768 
resolution of the internal display.

External Monitor in Display Closed Mode

When the PowerBook display is closed, an external VGA monitor supports the following 
resolutions

m Up to millions of colors:  640 x 480, 800 x 600, 1024 x 768, 1152 x 870, 1280 x 960,
1280 x 1024, 1600 x 1200, 1792 x 1344, 1856 x 1392, and 1920 x 1440

m Up to thousands of colors:  1792 x 1344, 1856 x 1392, and 1920 x 1440

External S-Video or Composite Television (NTSC)

An external NTSC video device or TV supports the following resolutions

m Up to millions of colors:  640 x 480, 720 x 480 (NTSC only), 800 x 600, 832 x 624,
and 1024 x 768 at 60 Hz
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External S-Video or Composite Television (PAL)

An external PAL video device or TV supports the following resolutions

m Up to millions of colors:  640 x 480, 720 x 576, 800 x 600, 832 x 624,
and 1024 x 768 at 50 Hz

Note:  Playback of DVD movies on an external monitor or television reduces the 
amount of video memory available for display. Fewer colors may be available at certain 
higher resolutions.

Size and Weight

m Height:  1.0 in. (26 mm)

m Width:  13.4 in. (341 mm)

m Depth:  9.5 in. (241 mm)

m Weight:  5.3 lbs. (2.4 kg)

Note:  Weight varies depending on configuration and manufacturing process.

Operating Environment

m Operating temperature:  50˚F to 95˚F (10˚C to 35˚C)

m Storage temperature:  –13˚F to 140˚F (–25˚C to 60˚C)

m Altitude:  3048 m (10,000 ft.) maximum 

m Shipping altitude:  10668 m (35,000 ft.) maximum 

m Relative humidity:  20% to 80% noncondensing
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B Care, Use, and Safety Information

Cleaning Your PowerBook

Follow these general rules when cleaning the outside of your computer and its components:

m Use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting moisture 
in any openings.

m Don’t use aerosol sprays, solvents, or abrasives.

Cleaning Your PowerBook Display

To clean your PowerBook screen, do the following:

m Shut down your PowerBook.

m Dampen a clean, soft, lint-free cloth or paper with water only and wipe the screen. Do not 
spray liquid directly on the screen.

Carrying Your PowerBook

If you carry your PowerBook in a bag or briefcase, make sure that there are no loose items 
(such as paper clips or coins) that could accidentally get inside the computer through the 
slot for the DVD drive.

Storing Your PowerBook

If you are going to store your PowerBook for an extended period of time, do one of the 
following to prevent your PowerBook battery from becoming completely depleted:

m Keep the power adapter connected.

m Fully charge your PowerBook battery before storing the computer.

m Fully charge and then remove your PowerBook battery when storing your computer 
(especially important when storing your computer for longer than 5 months).
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Safety Instructions for Setting Up and Using Your Computer

Plugging In the Power Adapter

Always leave space around your power adapter. Do not use this equipment in a location 
where airflow around the power adapter is confined. Always disconnect the power adapter 
and remove the battery before opening the computer to perform procedures such as 
installing memory or removing the hard disk.

Connecting a Phone Line to the Internal Modem

Always disconnect the phone cord before opening the computer to perform procedures 
such as installing memory or removing the hard disk.

Using Your PowerBook

When using your PowerBook or when charging the battery, it is normal for the bottom of the 
case to get warm. The bottom of the PowerBook case functions as a cooling surface that 
transfers heat from inside the computer to the cooler air outside. The bottom of the case is 
raised slightly to allow airflow that keeps the unit within normal operating temperatures.

Warning  Use only the power adapter that came with your PowerBook computer. 
Adapters for other electronic devices (including other PowerBook models and other 
portable computers) may look similar, but they may damage your computer. If your power 
adapter came equipped with a three-wire grounding plug (a plug that has a third 
grounding pin), then this plug will fit only a grounded AC outlet. If you are unable to 
insert the plug into the outlet because the outlet is not grounded, contact a licensed 
electrician to replace the outlet with a properly grounded outlet. Do not defeat the 
purpose of the grounding plug!

Warning  Do not connect a digital telephone line to the modem, because the wrong type 
of line could damage the modem.

Warning  Do not place your PowerBook on a pillow or other soft material when it is on, 
as the material may block the air flow vents and cause the computer to overheat.

Warning  Never turn on your computer unless all of its internal and external parts are in 
place. Operating the computer when it is open or missing parts can be dangerous and 
damage your computer.
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General Safety Instructions

For your own safety and that of your equipment, always take the following precautions. 

Disconnect the power plug (by pulling the plug, not the cord), remove the main battery, and 
disconnect the phone cord if any of the following conditions exists:

m You want to remove any parts (leave the cords disconnected as long as the keyboard 
is open)

m The power cord or plug becomes frayed or otherwise damaged

m You spill something into the case

m Your computer is exposed to rain or any other excess moisture

m Your computer has been dropped or the case has been otherwise damaged

m You suspect that your computer needs service or repair

m You want to clean the case (use only the recommended procedure described earlier)

Be sure that you always do the following:

m Keep your computer away from sources of liquids, such as drinks, washbasins, bathtubs, 
shower stalls, and so on.

m Protect your computer from dampness or wet weather, such as rain, snow, and so on.

m Read all the installation instructions carefully before you plug your computer into a 
wall socket.

m Keep these instructions handy for reference by you and others.

m Follow all instructions and warnings dealing with your system.

Important  The only way to disconnect power completely is to unplug the power cord and 
phone cords, and remove the battery. Make sure at least one end of the power cord is within 
easy reach so that you can unplug the computer when you need to.

Warning  Electrical equipment may be hazardous if misused. Operation of this product, 
or similar products, must always be supervised by an adult. Do not allow children access 
to the interior of any electrical product and do not permit them to handle any cables.

Warning  Never push objects of any kind into this product through the openings in the 
case. Doing so may be dangerous and result in fire or a dangerous electric shock.
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Ergonomics

Keyboard and trackpad

When you use the keyboard and trackpad, your shoulders should be relaxed. Your upper arm 
and forearm should form an angle that is slightly greater than a right angle, with your wrist 
and hand in roughly a straight line.

Use a light touch when typing or using the trackpad and keep your hands and fingers 
relaxed. Avoid rolling your thumbs under your palms.

Change hand positions often to avoid fatigue. Some computer users may develop discomfort 
in their hands, wrists, or arms after intensive work without breaks. If you begin to develop 
chronic pain or discomfort in your hands, wrists, or arms, consult a qualified health specialist.

Chair

An adjustable chair that provides firm, comfortable support is best. Adjust the height of the 
chair so your thighs are horizontal and your feet flat on the floor. The back of the chair 
should support your lower back (lumbar region). Follow the manufacturer’s instructions for 
adjusting the backrest to fit your body properly.

You may have to raise your chair so your forearms and hands are at the proper angle to the 
keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a footrest 
with adjustable height and tilt to make up for any gap between the floor and your feet. Or 
you may lower the desktop to eliminate the need for a footrest. Another option is to use a 
desk with a keyboard tray that’s lower than the regular work surface.

This Not this

This Not this
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External mouse

If you use an external mouse, position the mouse at the same height as your keyboard and 
within a comfortable reach.

Built-in display

Adjust the angle of the display to minimize glare and reflections from overhead lights 
and windows.

You can adjust the brightness of the screen when you take the computer from one work 
location to another, or if the lighting in your work area changes.

For more information

Go to www.apple.com/about/ergonomics
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Communications, Telephone, and Modem Regulation Information 

For information on FCC regulations, radio and television interference, and telephone and modem information as 
it relates to this product, see the files in the Communications Regulations folder, inside the Documents folder on 
your hard disk.

Laser Information

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.

Your computer is a Class 1 laser product. The Class 1 label, located in a user-accessible area, indicates that the 
drive meets minimum safety requirements. A service warning label is located in a service-accessible area. The 
labels on your product may differ slightly from the ones shown here. 

Laser Specifications

Laser on pickup unit (when reading a CD)

m Type:  Semiconductor GaAlAs laser 

m Wavelength:  790 nm

m Power out of objective lens:  3.3 mW

m Beam divergence:  horizontal 12° vertical 35° 

Laser on pickup unit (when reading a DVD)

m Type:  Semiconductor GaAs laser 

m Wavelength:  658 nm

m Power out of objective lens:  6 mW

m Beam divergence:  horizontal 8.5° vertical 27° 

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.

ENERGY STAR®

As an ENERGY STAR® partner, Apple has determined that standard configurations of this product using the
Mac OS 9 operating system meet the ENERGY STAR® guidelines for energy efficiency. The ENERGY STAR® 
program is a partnership with office product equipment manufacturers to promote energy-efficiency. Reducing 
energy consumption of office products saves money and reduces pollution by eliminating wasted energy.

Warning  Making adjustments or performing procedures other than those specified in your equipment’s 
manual may result in hazardous radiation exposure.

Class 1 label Service warning label
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